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or any product, extensibility is 
a very important requirement. 
This is more so in case of open 
source products. Joomla, being 
an open source CMS product, 

has many volunteers working on it. Joomla 
comes with most of the extensions to cater to 
your basic CMS needs — for example, menus, 
breadcrumbs, polls, advertisements, search, 
etc. However, in many cases, it is evident that 
all your requirements cannot be met by the 
out-of-the-box extensions. In those cases, 
you are left with two options: to search for 
free or commercial extensions developed and 

made available on the Internet, and to develop 
your own custom extensions. The power of 
extensions comes into the picture when you 
decide to implement your own extensions. 
Joomla provides a very clean and consistent 
infrastructure with which you can develop and 
deploy your custom extensions at run-time.

The following are the different types of 
extensions one can implement to extend your 
Joomla website:

Module: It is a Joomla extension that 
displays information on the website and can 
be positioned anywhere on it. Examples of 
some of the important modules are polls, 

•
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This is the fifth and last part of the series of articles on Joomla. In Part 1, we learnt the basics of 
Joomla and walked through the steps to create a professional website with it. In Part 2, we learnt to 
create our own custom template. In Part 3, we created our own custom module. In Part 4, we built 
custom components. In this last article in the series, we will explore extending Joomla by writing new 
plug-ins to meet your website’s needs. This part gives an overview of the Joomla framework and APIs, 
while showing how we can use them to create our own custom plug-ins.

Part 5:
Creating Plug-ins
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advertisements, user logins, etc. A module may also define 
one or more parameters and the values for them can be 
specified from the Administrator page.
Component: This Joomla extension presents the 
main content of the website and is necessary for user 
interaction. A component is always positioned as the main 
content and the navigation to it is provided by menu links 
or through a module. Examples of some of the important 
components are articles, forums, blogs, etc. From the 
administration point of view, the component provides more 
flexibility to the administrator than modules. A component 
generally has a site interface or front-end component and 
an administration interface or administrator component. 
For example, the Fireboard forums component provides 
a site interface where a website user can place a question 
in a forum, and an administrator interface where the 
administrator can create different forums and manage the 
user-access control.
Plug-ins: They are used to extend the core Joomla 
functionality and are important from the integration point 
of view. For example, if you want to display advertisements 
from Google AdSense on your website, one way would be 
to directly add the AdSense code to your website. Another 
would be to implement a plug-in to interface with the 
Google AdSense and build a module on top of it.
Template: It is mainly related to the display and 
positioning of your website content. This changes the look-
and-feel of the website. For example, if your website is 
currently on a two-column template and you want it to be 
on a three-column template, then you may develop a new 
three-column template and use that for your website.

Planning your custom extension
Continuing with our example organisation, let us assume 
that you are an EventOrg company that organises events for 
corporations and groups. You have an events calendar on 
your website, as shown in Figure 1, which shows upcoming 
events and provides links to view the details on them. You 
may refer to Part 1 of this series to find out the details 
about adding the Events component to your website.

For any website, making content accessible and searchable 
is a key requirement. This allows visitors to search the content 
using free text. And, it becomes more important if the website 
contains loads of information. 

On our EventOrg website, we added an Events 
Feedback custom component in Part 4 of this series. This 
component allowed visitors to post their feedback on the 
events organised by EventOrg, as shown in Figure 2. Now, 
if visitors want to search for all the details pertaining to the 
Tadoba forest trip, and then search for, say, text tadoba, no 
search result is returned, as shown in Figure 3.

You may wonder why the event information doesn’t 
show up even though the records are available in the back-
end database! Well, search is handled by Joomla plug-ins. 
Plug-ins sit at the bottom of the system and can be used to 
modify core Joomla functionality. The search plug-in decides 

•
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the search areas, which will be included into the search. For 
example, Figure 3 shows that Articles, Web Links, Contacts, 
Categories, Sections, and News Feeds are currently being 
searched through to find the matching record.

The JEvents component provides a search plug-in to 
search the events. But this is disabled by default as shown 
in Figure 4. To see that, on the administrator page, click 
on Extensions—>Plugin Manager and in the Select Type 
drop-down option, select Search. This will show you the list 
of search plug-ins and will show that the ‘Search - Events 
for Joomla 1.5’ plug-in is disabled.

Enable the plug-in and try the same search on your 
EventOrg website. This time you will see the matching 
event showing up in the search results, as in Figure 5. You 
will also notice that the Events check-box is included in the 
list of Search Only.

So far so good! Coming back to our original thought, say, 
EventOrg decides that the posted feedback should be used as 
an advertising tool and target the website visitors. After much 
brainstorming, if you came to a conclusion that the feedbacks 
will be made searchable and jot down the requirements, you 
may come up with the following list:
1. When the visitor enters a search text, the posted events 

Figure 1: Event calendar with the latest events

Figure 2: Event feedback component view

Figure 3: Search result with no matching events
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feedback must be included into the search.
2. All the events’ feedback matching the search criteria must 

be displayed on the website under the search results.
3. The feedback must appear under the event title for which 

the feedback was posted.
Good! But, before we jump on to designing, let us briefly 

discuss what a Joomla plug-in is, the different types of plug-
ins that are supported, the purpose of each one of them, the 
interfaces they provide in order to develop our own custom 
plug-in, etc.

Joomla plug-ins
In short, a plug-in sits at the bottom of the Joomla 
framework and allows developers to modify the core Joomla 
functionality—for example, the previously-discussed search 
plug-in. So, if someone is searching for a book name, Joomla 
provides the necessary plug-in infrastructure, using which you 
can implement a plug-in to search for the matching book titles 
on Amazon.com and show the results on your website.

As shown in Figure 6, you can see the types of plug-ins 
supported on the Plugin Manager page.  The following is 
the list of supported plug-ins:

authentication: Plug-ins of this type provide the user •

authentication functionality. Version 1.5 of Joomla includes 
Joomla, OpenID, LDAP, and GMail as the authentication 
plug-ins. Although Joomla is used as the core 
authentication mechanism on any Joomla-based website, 
you can modify it by putting a LDAP mechanism in place.
content: This type of plug-in allows content to be modified 
after it is retrieved from the database and before it is 
rendered for the user. The content can be modified, 
formatted, or supplemented with additional information. 
For example, a plug-in to highlight certain keywords on all 
the pages, will come under the content plug-in type.
editors: This is for content editors such as TinyMCE and 
XStandard Lite
editors-xtd: These plug-ins extend the editor’s capability 
by adding buttons to them that add more functions such as 
inserting an image, inserting page breaks, and a read-more 
functionality. For example, a plug-in to allow the user to 
insert a video from YouTube into the content will come 
under the editors-xtd plug-in type.
Search: These add search capability to particular items. 
Currently, items of certain types of articles, Web links, 
contacts, categories, sections, and news feeds are 
supported. For example, a plug-in to allow the user to 
search a PDF document will come under this category.
System: Plug-ins of this type interface with core Joomla 
system functions and allow control over foundation tasks 
such as SEF (Search Engine Friendliness), debugging, 
logging, caching, legacy support, etc.
user: This type are used to synchronise a user database 
with another user privilege system.
Xmlrpc: These plug-ins handle the XML-RPC requests. 
For example, Blogger provides an XML-RPC interface to 
post blogs to blogspot.com from the Joomla website.
Each of the plug-in types handle one or more Joomla 

events. Plug-ins implement the methods and register them 
against an event. When that particular event occurs in 
the system, the corresponding plug-in method is invoked. 
For example, let’s assume that you want to handle the 
authentication failure and take some action, which may include 
displaying a nice page suggesting the user requests for a 
forgotten password. In that case, implement a method in your 
custom plug-in, say, handleAuthenticationFailure and then 
register this method against the event onAuthenticateFailure 
so that the handleAuthenticationFailure method is invoked 
each time there is an authentication error in the system.

There are numerous events defined by Joomla for which 
implementation can be provided in the custom plug-in you 
develop. This article primarily focuses on the search plug-in. 
Other events are thus out of the scope of this article.

Following are the search events of our interest:
onSearchAreas: This is triggered by the system to request 
from search plug-ins what areas each of them cover. The 
handler for this event must return the ID and name of the 
search area—for example, news feeds, articles, etc.
onSearch: This is triggered when a search has been 
requested. The handler of this event must take care of 
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Figure 5: Matching events after the plug-in is enabled

Figure 6: List of supported plug-in types

Figure 4: Disabled Events search plug-in
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searching the content and returning the result in a format 
understandable by the Joomla framework. The handler 
method must accept the following parameters:

The target search string
A string matching option (exact|any|all)
A string ordering option (newest|oldest|popular|alpha|
category)
An array if restricted to areas, null if ‘search all’

 The handler method must return an array of the following 
values to the Joomla framework:

href 
title 
section 
created 
text 
browsernav 

Great! Now that we have the extension requirements 
clearly identified and the plug-in concepts understood, 
let us see how we go about addressing each one of them 
(refer to Table 1).

Based on the requirements and design decisions listed 
in Table 1, let us do some detailed design work. First, 
let us take a look at the events table and the columns 
that we need to use in the new extension. Bring up the 
phpMyAdmin page (refer to Part 1 of the series for 
details). The main page shows the database list and other 
system information as shown in Figure 7.

Click on the database that is being used by your Joomla 
installation, say, ‘joomla15’. This will show all the tables in 
that database, as in Figure 8.

The ‘Events’ component uses the jos_events table to store 
the events details. The ‘Events Feedback’ component uses the 
jos_events_feedback table to store the events feedback. You 
can select a table entry and click on the Browse button next to 
the table name to view the table column details.

In order to display the search results, the following tables 
and columns are of interest to us: 

Table: 
jos_events: If you are wondering what jos_ stands 
for and whether you should care for it or not, the 
answer is, “Yes!” If you recall the Joomla installation 
steps from Part 1 of the series, we had specified 
the database prefix while specifying the database 
settings. The installation creates the tables with the 
table name prefixed with the database prefix. Now 
that we have understood where jos_ comes from, 
the next thought that’ll hit you will be whether to 
use the table name jos_events in your module code; 
and if so, will it work only if the database prefix is 
set to jos_ during the installation of Joomla. This 
creates a dependency on the database prefix value. 
So, how do we make our module independent of the 
database prefix? The answer is straightforward: use 
#_ in place of jos_ while referring to the table name 
in your SQL queries. So, rather than using the table 
name jos_events, use #__events.














•


Columns:
title: This column value will be used to display the 
event name in the search result.
created: This value will be returned to the Joomla 
framework.
id: This will be used to form the href in the events 
details.
hits: This supports the most popular ordering.
state: This column value will filter out the events 
that are enabled.
access: This is to filter out the records to which the 
user has access.

•











Figure 7: phpMyAdmin page

Figure 8: Joomla tables

Table 1: RequiRemenTs and design 
decisions
Requirement Design decisions

Req# 1 A custom search plug-in will be 
developed to include the events 
feedback into the search areas. The 
plug-in will provide the handlers for 
the following events:
• onSearchAreas
• onSearches

Req# 2 & 3 The onSearch event handler will 
return the array of the following 
values to the Joomla framework, so 
that it can display the information in 
the required format:
• title
• created
• text
• section 
• href
• browsernav
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catid: This column value will be used to find the 
section.

Table: 
jos_events_feedback: use #__events_feedback in 
your SQL.

Columns:
message: This column value displays the event 
feedback in the search results.
created: This supports the oldest-first or newest-first 
ordering.
event_id: This column value will filter the matching 
event records.

Table: 
jos_categories: Use #__categories in your SQL.

Columns:
title: This column value supports the ordering by 
category.
id: This filters the matching event records.
access: This filters out the records on which the user 
has the access.

Table: 
jos_sections: Use #__sections in your SQL.

Columns:
id: This filters the matching event records.

Joomla framework and available APIs for writing 
custom extensions
Joomla! has a layered architecture. The layers (as shown 
in Figure 9) are as follows:

Framework Tier: This layer contains the core Joomla 
framework and the plug-ins.
Application Tier: This layer provides the necessary 
infrastructure to build modules, components, templates, 
and other custom applications. You may use only the 
framework and the application tiers to develop your 
applications.
Extensions Tier: This provides the necessary support 
to extend Joomla. It provides the required support 
to implement components, modules and templates. 
This tier also contains the out-of-box Joomla modules, 
components, and templates.
The Joomla framework comes with numerous classes 

that you should know about in order to work with Joomla 
effectively. This article will cover the classes and methods used 
in the development of the new plug-in. Covering the details 
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of each Joomla API is out of the scope of this article. Refer to 
the ‘Joomla 1.5 API Reference’ at api.joomla.org/li_Joomla-
Framework.html for the complete list of APIs and their 
documentation.

Some of the important classes/objects we will be 
working with are:

JFactory: This is the factory class. It implements the 
famous ‘Factory pattern’. This class is used to create 
various Joomla framework classes. We will use the 
getDBO() method to get the global JDatabase object. 
The getDBO() method will create an instance of  the 
JDatabase object if it does not exist already, and returns 
the object reference to the caller. We will also use the 
getUser() method to get the global JUser object, which 
contains the user information. The getUser() method will 
create an instance of the JUser object, if it does not exist 
already, and return the object reference to the caller.
JDatabase: This Joomla class provides all the methods 
related to database access. It takes the database 
connection details from the Joomla global configuration. 
The class provides convenient methods to run an SQL 
query, iterate through the result sets, retrieve the 
column data, etc.
JUser: This class handles all the application interactions 
with a user. The class provides convenient methods to 
fetch user information, such as, access ID, user name, e-
mail, last-visited date, etc.
JText: This is a text-handling class that translates a text 
into the language used by the site.
JPluginHelper: This is a helper class to load plug-in files 
and data. It provides methods to get the plug-in data like 
the plug-in name, type, etc, to import plug-in files, and 
to check whether a plug-in is enabled or not. We will be 
using the getPlugin() method to get the plug-in data 
loaded, which will be further utilised to read the plug-in 
parameters and their values.
JParameter: This class provides methods to work with 
the parameters. We will use the constructor to construct 
the plug-in parameters and use the def() method to set 
the default value for the plug-in parameter, if it is not 
already set.
mainframe: This is a global variable in Joomla that has 
lots of useful methods attached to it. We will use the 
registerEvent() method to register our plug-in methods 
against a Joomla search event.
Now that we have got an overview of the classes/objects 

and the methods we will be using in the new plug-in 
development, it is the time to move to the actual coding of 
the plug-in.

Creating custom plug-ins
This article does not make any assumption about the 
development IDE. However, after learning the basics, when 
you become serious about Joomla development, PHPEclipse 
will be a very useful Eclipse IDE plug-in. Meanwhile, I will 
assume that you have a text editor.

•
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Figure 9: Joomla! architecture
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The following steps create a new component:
Step 1: Choose your working directory, say, <your home 

directory>/joomla15dev.
Step 2: Create a directory by name plg_search_

eventsfeedback under your working directory.
Step 3: Go to the <your home directory>/joomla15dev/

plg_search_eventsfeedback directory.
Step 4: Create and save the code shown in Listing 1 in 

a file named eventsfeedback.php. The code implements the 
functionality to display the matching events feedback on the 
website when the user searches for a free text.

Listing 1: The eventsfeedback.php file

<?php

/*

 * Created on 10/07/2008

 *

 * @package  ECSJoomlaPlugins

 * @author  Ajit Kumar

 * 

 * This is a plug-in to search for the events feedback

 * 

 * Following are the parameters used by this plug-in:

 *  (1) search_limit - how many search results should be 

displayed 

 */

 

?>

<div>

<?php

// no direct access

defined( ‘_JEXEC’ ) or die( ‘Restricted access’ );

$mainframe->registerEvent( ‘onSearch’, ‘plgSearchEventsFeedback’ );

$mainframe->registerEvent( ‘onSearchAreas’, 

‘plgSearchEventsFeedbackAreas’ );

/**

 * @return array An array of search areas

 */

function &plgSearchEventsFeedbackAreas() {

 static $areas = array(

  ‘eventsfeedback’ => ‘Events Feedback’

 );

 return $areas;

}

/**

 * Events Feedback Search method

 *

 * The sql must return the following fields that are used in a common 

display

 * routine: href, title, section, created, text, browsernav

 * @param string Target search string

 * @param string mathcing option, exact|any|all

 * @param string ordering option, newest|oldest|popular|alpha|categ

ory

 * @param mixed An array if the search it to be restricted to areas, 

null if search all

 */

function plgSearchEventsFeedback( $text, $phrase=’’, $ordering=’’ 

,$areas=null) {

 

 $db   =& JFactory::getDBO();

 $user =& JFactory::getUser();

 

 // load plugin params info

  $plugin   =& JPluginHelper::

getPlugin(‘search’, ‘eventsfeedback’);

  $pluginParams = new JParameter( $plugin->params );

 

 $limit   = $pluginParams->def( ‘search_limit’, 

50 ); 

 

 $text = trim( $text );

 if ($text == ‘’) {

  return array();

 }

 $wheres = array();

 switch ($phrase) {

  case ‘exact’:

   $wheres2 = array();

   $wheres2[] = “LOWER(a.title) LIKE 

‘%$text%’”;

   $wheres2[] = “LOWER(d.message) LIKE 

‘%$text%’”;

   $where = ‘(‘ . implode( ‘) OR (‘, 

$wheres2 ) . ‘)’;

   break;

  case ‘all’:

  case ‘any’:

  default:

   $words = explode( ‘ ‘, $text );

   $wheres = array();

   foreach ($words as $word) {

    $wheres2 = array();

    $wheres2[] = “LOWER(a.

title) LIKE ‘%$word%’”;

    $wheres2[] = “LOWER(d.

message) LIKE ‘%$word%’”;

    $wheres[] = implode( ‘ OR 

‘, $wheres2 );

   }

   $where = ‘(‘ . implode( ($phrase == 

‘all’ ? ‘) AND (‘ : ‘) OR (‘), $wheres ) . ‘)’;

   break;

 }

 $morder = ‘’;

 switch ($ordering) {
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  case ‘oldest’:

   $order = ‘d.created ASC’;

   break;

            

  case ‘popular’:

   $order = ‘a.hits DESC’;

   break;

            

  case ‘alpha’:

   $order = ‘a.title ASC’;

   break;

            

  case ‘category’:

   $order = ‘b.title ASC, a.title ASC’;

   $morder = ‘a.title ASC’;

   break;

            

  case ‘newest’:

  default:

   $order = ‘d.created DESC’;

   break;

 }

 // search events items

 $eventstitle=_CAL_LANG_CAL_TITLE;

 $query=”SELECT a.title AS title,”

 . “\n a.created AS created,”

 . “\n d.message AS text,”

 . “\n CONCAT(‘$eventstitle’,’/’,b.title) AS section,”

 . “\n CONCAT(‘index.php?option=com_events&task=view_

detail&agid=’,a.id) AS href,”

 . “\n ‘2’ AS browsernav”

 . “\nFROM #__events AS a”

 . “\nINNER JOIN #__categories AS b ON b.id=a.catid AND 

b.access <=’”.(int) $user->get( ‘aid’ ).”’”

 . “\nLEFT JOIN #__sections AS u ON u.id = a.catid”

 . “\nRIGHT JOIN #__events_feedback AS d ON d.event_id = 

a.id”

 . “\nWHERE ($where)”

 . “\n AND a.state=’1’ AND a.access<=’”.(int) $user-

>get( ‘aid’ ).”’”

 . “\n AND b.published = ‘1’”

 . “\nORDER BY “ . ($morder ? $morder : $order)

 ;

 $db->setQuery( $query, 0, $limit );

 $list = $db->loadObjectList();

 

 return $list;

}

?>

</div>

 

Step 5: Create and save the following code in the 
eventsfeedback.xml file:

<?xml version=”1.0” encoding=”utf-8”?>

<install version=”1.5” type=”plugin” group=”search”>

 <name>Search - Events Feedback</name>

 <author>Ajit Kumart</author>

 <creationDate>July 2008</creationDate>

 <authorEmail>ajit.kumar@empowerconsultancy.in</authorEmail>

 <authorUrl>www.empowerconsultancy.in</authorUrl>

 <version>1.0</version>

 <description>ALLOWS SEARCHING OF ALL EVENTS FEEDBACK</

description>

 <files>

  <filename plugin=”eventsfeedback”>eventsfeedback.

php</filename>

 </files>

 <params>

  <param name=”search_limit” type=”text” size=”5” 

default=”50” label=”Search Limit” description=”Number of Search items 

to return”/>

 </params>

</install>

This is the XML descriptor file for the plug-in. This file 
contains the installation details about the plug-in. It also 
contains the files that constitute this plug-in for the website. 

This brings us to the end of coding the new plug-in. 
The next important step is to package the plug-in code and 
install it in Joomla.

Packaging a new plug-in
Step 1: Go to the <your home directory>/

joomla15dev/plg_seach_eventsfeedback directory, if you 
are not already there.

Step 2: Create a zipped file, plg_eventsfeedback.zip, and 
add the following component files to it:

eventsfeedback.php
eventsfeedback.xml

Installing a new plug-in
Step 1: Launch your Administrator page
Step 2: On the Administrator page, click on the 

Extensions->Install/Uninstall menu item to bring up the 
Extension Manager page. 

Step 3: Specify the plug-in zipped file name by 
browsing through your folder structure and click on Upload 
File & Install button. This will install the plug-in and a 
message will appear indicating a successful installation, as 
shown in Figure 10.

Click on the Plugins tab to verify that the new plug-
in ‘Search - Events Feedback’, has been installed and 
the plug-in details from the descriptor file shows up, as 
shown in Figure 11.

Select the check box next to ‘Search - Events Feedback’ 
and click on the Enable button on the top to enable it. 

Now that the plug-in is installed and enabled, we are ready 
to use it on our website. No further configuration is needed.

‘Legacy: 1.0 text’, as shown in Figure 12, appears on the 
top tool bar if the legacy plug-in is enabled.

•
•
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Well, this is all we needed to install the new plug-in. Let us 
see how the search results appear on the website now.

Enter your website URL in the browser. Enter the ‘text 
tadoba’ in the search area and hit the Enter key. You will see 
the matching events along with the feedback in the search 
result, as shown in Figure 13. You will also see a new Events 
Feedback check box appearing in the list of Search Only.

Looks good! Add or remove some code from the 
component code and get a feel of how things are working.

This brings us to a point where we have written a new 
plug-in, installed it, and used it on our website. But, wait! 
Before we conclude, for various obvious reasons, it is 
equally important to know how we uninstall the plug-in, if 
we later want to. During the development of more complex 
plug-ins, it will be inevitable to go through an indefinite 
number of installs/uninstalls. So, let us look at the steps 
involved in uninstalling the new plug-in.

Uninstalling the plug-in
Step 1: On the Administrator page, click on the 

Extensions->Install/UnInstall menu item.
Step 2: Click on the Plugins tab.
Step 3: Select the Search - Events Feedback plug-in 

and click on the Uninstall toolbar button on the top, as 

shown in Figure 14.
This will uninstall the plug-in and a message will appear 

indicating a successful uninstall.
This brings us to the end of our discussion about 

Joomla extensions, as well as to the end of the series on 
Joomla. 

Before we test the new plug-in, make sure that the 
System-Legacy plug-in is enabled. This is required 
for the Events component to work with Joomla 

version 1.5. If you are able to see the Events calendar on 
your website, this should already have been enabled. If not, do 
so by clicking on Extension®Plugin Manager and enabling the 
System-Legacy plug-in. 

RefeRences: 
XAMPP download—www.apachefriends.org/en/
xampp.html
Joomla 1.5 download—www.joomla.org
Joomla 1.5 API reference—api.joomla.org/li_Joomla-
Framework.html 
Web developer—addons.mozilla.org/en-US/firefox/
addon/60
PHP Eclipse—www.phpeclipse.de/tiki-view_articles.php
Previous Joomla articles—joomlatoday.blogspot.com













Figure 14: Extension Manager for Uninstall

Figure 10: Events feedback search plug-in installed

Figure 11: Events feedback search plug-in entry

Figure 12: Legacy mode enabled

Figure 13: Search results after the Events feedback search plug-in is installed
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trainer with Empower Consultancy & Services (www.
empowerconsultancy.in). Support for all his Joomla articles, 
including this one, can be found at joomlatoday.blogspot.com. 
You can also send your technical and training-related queries 
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